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Chapter 3
Editing Equations

This chapter describes the mechanics of creating mathematical ex
sions and making changes in existing mathematical expressions.

The following sections make up this chapter:

Building expressions
How to create mathematical expressions in a straightforward way by just 
typing a stream of characters. How to create expressions by exploiting their 
structure.

Editing an existing expression
Inserting and deleting operators, changing the names of variables, using
Delete, Paste, and Copy to streamline your editing. How to add a line b
to a lengthy expression.

Rearranging your worksheet
How to move one or more expressions to another part of your workshee
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Building expressions 

You can create many mathematical expressions by simply typing in a stream of 
characters. Certain characters, like letters and digits, make up parts of names an
numbers. Other characters, like *  and +, represent “operators.” For example, if you 
type the characters

3/4+5^2=

you get the result shown below:

Figure 3-1: An expression and its computed value.

You can type many of these operators by clicking on the appropriate button in th
various operator palettes. Each button on the Math Palette, described on page 19
up one of these operator palettes. Most of the operators used in this chapter are 
arithmetic palette which you can open by clicking on the left-most button (the one w
a calculator on it). For example, instead of typing 5^2 , type 5, click on the button 
labeled  on the arithmetic palette, and type 2 in the placeholder.

On the surface, Mathcad's equation editor seems very much like a simple text ed
but there's more to it than this. Mathematical expressions have a well-defined stru
and Mathcad's equation editor is designed specifically to work within that structur
Mathcad, mathematical expressions are not so much typed in as they are built.

Mathcad automatically assembles the various parts that make up an expression
the rules of precedence and some additional rules that simplify entering denomin
exponents, and expressions in radicals. For example, when you type /  to create a 
fraction, Mathcad stays in the denominator until you explicitly tell it to leave by click
on the fraction bar. This means that the characters 3/4+5^2  generate what you see in
Figure 3-1 rather than 

Typing in names and numbers

When you type in names or numbers, Mathcad behaves very much like a standard
processor. As you type, you'll see the characters you type appear behind a vertic
editing line. The left and right arrow keys move this vertical editing line to the left
to the right a character at a time, just as they would in a word processor. There a
however, two important differences.

xy

3
4
--- 52+
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■ As it moves to the right, the vertical 
editing line leaves behind a trail. This 
trail is a “horizontal editing line.” Its 
importance will become apparent in the 
next section when you begin working with operators.

■ Unless the equation you've clicked in already has an operator in it, pressing [Space ] 
will turn the math region into a text region. It is not possible to turn a text regi
back into a math region.

Typing in operators

Operators are symbols like “+” and “−” that link variables and numbers together to 
form expressions. The variables and numbers linked together by operators are c
“operands.” For example, in an expression like:

the operands for the “+” are x and y. The operands for the exponent operator are a and 
the expression . 

The key to working with operators is learning to specify what variable or expressio
to become an operand. There are two ways to do this: 

■ You can type the operator first and fill in the placeholders with operands, or 

■ You can learn how to use the editing lines to specify what variable or express
you want to turn into an operand.

The first method feels more like you're building a skeleton and filling in the detail
later. You may find this method easier to use when you're either building very 
complicated expressions, or when you're working with operators like summation
integration which require many operands and lack a natural typing order.

The second method feels more like straight typing and can be much faster when
expressions are simple. In practice, you may find yourself switching back and fort
the need arises.

Here's how to create the expression  using the first method:

■ Press ̂  to create the exponent operator. 
You'll see two placeholders.

■ Click in the lower placeholder and type 
a.

■ Click in the upper placeholder.

ax y+

x y+

ax y+
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■ Type +.

■ Click in the remaining placeholders and 
type x  and y .

To use the editing lines to create the expression , proceed as follows:

■ Type a. The line beneath the a indicates 
that a will become the first operand of 
whatever operator you type next.

■ Press ̂  to create the exponent operator. 
As promised, a becomes the first oper-
and of the exponent. The editing lines 
now surround another placeholder. 

■ Type x+y  in this placeholder to com-
plete the expression.

Note that in this example, you could type the expression the same way you'd say
loud. However, even this simple example already contains an ambiguity. When y
say “a to the x plus y” there's no way to tell if you mean  or . For more 
complicated expressions, the number of ambiguities increases dramatically. 

Although you could resolve any of these ambiguities by using parentheses, doin
can quickly become cumbersome. A better way is to use the editing lines to specif
operands of whatever operator you type. The following example illustrates this b
describing how to create the expression  instead of .

■ Type a^x  as you did in the previous 
example. Note how the editing lines hold 
the x between them. If you were to type 
+ at this point, the x would become the 
first operand of the plus.

■ Press [Space ]. The editing lines now 
hold the entire expression . 

■ Now type +. Whatever was held between 
the editing lines now becomes the first 
operand of the plus.

ax y+

ax y+ ax y+

ax y+ ax y+

ax
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■ In the remaining placeholder, type y .

Multiplication

A common way to show multiplication between two variables on a piece of paper 
place them next to each other. For example, expressions like ax or  are easily 
understood to mean “a times x” and “a times the quantity x plus y,” respectively. 

This cannot be done with Mathcad variables for the simple reason that when you
ax , Mathcad has no way of knowing whether you mean “a times x” or “the variable 
named ax.” Similarly, when you type a(x+y) , Mathcad cannot tell if you mean “a 
times the quantity x plus y” or whether you mean “the function a applied to the argument 

.” 

In the special case when you type a numerical constant followed immediately by
variable name, such as 4x , Mathcad interprets the expression to mean the constan
multiplied by the variable: . Mathcad displays a space between the constant
the variable to indicate that the multiplication is implied. You can produce math 
notation in this way that closely approximates the notation you see in textbooks 
reference books. Note that Mathcad reserves certain letters, such as “i” for the imaginary 
unit and “o” for octal, as suffixes for numbers, and in these cases will not attempt
multiply the number by a variable name but rather will treat the expression as a s
number with a suffix.

To avoid ambiguity, we recommend that you press *  explicitly to indicate multiplica-
tion, as shown in the following example:

■ Type a followed by * . Mathcad inserts 
a small dot after the “a” to indicate mul-
tiplication.

■ In the placeholder, type the second fac-
tor, x .

An annotated example 

When it comes to editing equations, knowing how to use the editing lines assum
importance similar to knowing where to put the flashing vertical bar you see in m
word processors. A word processor can get away with a vertical bar because tex
inherently one-dimensional, like a line. New letters go either to the left or to the r
of old ones. Equations, on the other hand, are really two-dimensional. Their structure 
is more like a trees with branches than like a line of text. As a result, Mathcad ha
use a two-dimensional version of that same vertical bar. That's why there are two edit
lines: a vertical line and a horizontal line.

Suppose, for example, that you want to type the slightly more complicated expre

a x y+( )

x y+

4 x⋅
Building expressions 59



e 
Watch what happens to the editing lines in the following steps:

■ Type x-3*a^2 . Since the editing lines 
contain just the “2,” only the “2” be-
comes the numerator when you press the 
/ . Since we want the whole expression, 

, to be the numerator, we must make the editing lines hold that entir
expression.

■ To do so, press the [Space ]. Each time 
you press the [Space ], the editing lines 
hold more of the expression. You'll need 
to press [Space ] three times to enclose 
the entire expression.

■ Now press /  to create a division bar. 
Note that the numerator is whatever was 
enclosed between the editing lines when 
you pressed / .

■ Now type -4+  and click on the button 
labeled “ ” on the arithmetic palette. 
Then type y+1  under the radical to com-
plete the denominator. 

■ To add something outside the radical 
sign, press [Space ] twice make the ed-
iting lines hold the radical. For example, 
to add the number π to the denominator, 
press [Space ] twice.

■ Press +. Since the editing lines were 
holding the entire radical, it is the entire 
radical that becomes the first operand 
when you press +.

■ Click on the button labeled “π” on the 
arithmetic palette. This is one of Math-
cad's built-in variables.

x 3 a2⋅–

4– y 1++
------------------------------

x 3 a2⋅–
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Editing an existing expression 

This section describes how to make changes to an existing expression.

The simplest changes you can make are discussed in “Changing a name or numb
page 61. Here, the underlying tree structure of a math expression doesn't matter
result, the equation editor behaves very much like a text editor.

Most difficulties in editing equations arise from working with operators. That's beca
it's only when you start working with operators that the underlying tree structure 
math expression shows up. 

The next few sections describe the three things you can do with an operator: inse
an operator, deleting an operator, or replacing one operator with another.

The equation editor normally works from left to right. If you want to insert an opera
before an existing expression, or if you want to apply a function to an existing 
expression, see “Inserting an operator” on page 62 and “Applying a function to a
expression” on page 66.

Although Mathcad inserts parentheses wherever required to prevent ambiguity, 
may at times want to add parentheses to clarify an expression or delete extrane
parentheses. To do so, use the techniques described in the sections “Inserting pa
ses” on page 67 and “Deleting parentheses” on page 68.

When working with a complicated expression, it is often easier to work with more
manageable subexpressions within it. The sections “Moving parts of an expressio
page 68 and “Deleting parts of an expression” on page 69 describe how to use Cut, 
Copy, and Paste to do so.

Changing a name or number      

To edit a name or number:

■ Click on it with the mouse. This places the editing lines wherever you clicked
mouse. 

■ Move the editing lines if necessary by pressing the [→] and [←] keys. Alternatively, 
place the mouse pointer wherever you want the editing lines to go, and click 
mouse.

■ If you type a character, it will appear just to the left of the editing lines. Pressi
[Bksp ] removes the character to the left of the editing lines. Pressing [Delete ] 
removes the character to the right of the editing lines.

If you need to change several occurrences of the same name or number, you ma
it useful to choose Replace from the Edit  menu. To search for a sequence of characte
choose Find from the Edit  menu. These commands are discussed further in Chapte
“Text.”
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Inserting an operator

The easiest place to insert an operator is between two characters in a name or t
numbers in a constant. For example, here is how to insert a plus sign between tw
characters:

■ Place the editing lines where you want 
the plus sign to be.

■ Press the + key.

Note that Mathcad automatically inserts a space on either side of the plus sign. Y
should never need to insert a space when typing an equation. Mathcad inserts s
automatically wherever doing so is appropriate. In fact, if you do try to insert a sp
Mathcad assumes you meant to type text rather than math and converts your math
into a text region accordingly. 

Operators such as division and exponentiation result in more dramatic formatting
changes. For example, when you insert a divide sign, Mathcad moves everything
comes after the divide sign into the denominator. Here's how you insert a divide

■ Place the editing lines where you want 
the divide sign to be. 

■ Press the /  key. Mathcad reformats the 
expression to accommodate the division.

Some operators require only one operand. Examples are the square root, absolute
and complex conjugate operators. To insert one of these, place the editing lines on
side of the operand and press the appropriate keystroke. Many of these operato
available on the arithmetic palette as well. For example, to turn x into  do the 
following:

■ Place the editing lines around the “x,” 
either preceding or following the charac-
ter.

■ Press \  to insert the square root operator.

x
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Applying an operator to an expression

The methods described in the previous section work most predictably when you 
to apply an operator to a variable or a number. If, however, you want to apply an ope
to an entire expression there are two ways to proceed:

■ You can surround that expression in parentheses and proceed as described 
previous section, or

■ You can use the editing lines to specify the expression you want to apply the ope
to.

Although the first method may be more intuitive, it is definitely slower since you w
need to type pairs of parentheses. The more efficient second method is the subj
this section. The sections “Inserting parentheses” on page 67 and “Deleting pare
ses” on page 68 describe ways to work with parentheses more efficiently. 

The editing lines consist of a horizontal line and a vertical line that moves left to r
along the horizontal line. To make an operator apply to an expression, select the
expression by placing it between the two editing lines. The following examples s
how typing *c  results in completely different expressions depending on what was
selected.

■ Here, the two editing lines hold only the 
numerator. This means any operator you 
type will apply only to the numerator.

■ Typing *c  results in this expression. 
Note how the expression held between 
the editing lines became the first operand 
of the multiplication.

■ Here, the editing lines hold the entire 
fraction. This means any operator you 
type will apply to the entire fraction.

■ Typing *c  results in this expression. 
Note how the everything between the 
editing lines became the first operand of 
the multiplication. 

■ Here, the editing lines hold the entire 
fraction as they did in the previous exam-
ple. However, this time the vertical edit-
ing line is on the left side instead of on 
the right side. 
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■ Typing *c  results in this expression. 
Note how the expression enclosed by the 
editing lines became the second rather 
than the first operand of the multiplica-
tion. This happened because the vertical 
editing line was on the left side rather than the right side. 

Now that you know the significance of what's held between these two editing lines
pertinent question becomes “How do I control what's held between the two editin
lines?”

One way to control the length of the editing lines is to click on an operator. When
click on an operator, you make the pair of editing lines hold that operator together
everything that operator applies to. Depending on exactly where on the operator
click, you'll find the vertical editing line either on the left or on the right. Use the 
[Insert ] key to move it from one side completely to the other, or use the left an
right arrow keys to move a character at a time.

A second way to control the length of the two editing lines is to press [Space ] to cycle 
through all possible positions of the editing lines. Each time you press [Space ] the 
editing lines grow progressively longer. As they do so, they enclose more and mo
the expression, until eventually, they enclose the entire expression. Pressing [Space ] 
one more time brings the editing lines back to where they were when you started

The following example walks you through a short cycle:

■ This is the starting position. The two 
editing lines hold just the single variable 
“d.”

■ Pressing [Space ] makes the editing 
lines grow so that they now hold the 
entire denominator.

■ Pressing [Space ] once makes the edit-
ing lines grow again so that they now 
hold the entire expression. 

■ At this point, the editing lines can't be-
come any longer. Pressing [Space ] 
brings the editing lines back to the start-
ing point of the cycle.

You'll notice that in stepping through the previous cycle there was never an interme
step in which the editing lines held just the numerator. Nor was there ever a step
which the editing lines held just the a or just the b in the numerator. That's because th
sequence of steps the editing lines go through as you press [Space ] depends on the 
starting point of the cycle.

To set the starting point of the cycle, you can either click on the appropriate part o
expression as described earlier, or you can use the arrow keys to move around 
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expression. The arrow keys walk the editing lines through the expression in the 
indicated direction. Keep in mind however that the idea of “up” and “down” or “le
and “right” may not always be clear, particularly when the expression becomes v
complicated or when the expression involves summations, integrals and other adv
operators.

Deleting an operator

To delete an operator connecting two variable names or constants:

■ Place the editing lines after the operator.

■ Press the [BkSp] key.

Now you can easily insert a new operator to replace the one you deleted just by ty
it in.

You can also delete an operator by placing the editing lines before it and pressin
[Delete ] key instead. For example:

■ Place the editing lines before the opera-
tor.

■ Press the [Delete ] key.

In the above examples, it is easy to see what “before” and “after” mean because
expressions involved naturally flow from left to right, the same way we read. Fract
behave the same way. Since we would naturally say “a over b,” putting the editing lines 
“after” the division bar means putting them just before the b. Similarly, putting the 
editing lines “before” the division bar means putting them immediately after the a. The 
following example illustrates this:

■ Place the editing lines after the division 
bar. 

■ Press the [BkSp] key.

To delete an operator having only one operand (for example, ,  or ):x x x!
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■ Position the editing lines just after the 
operator. 

■ Press the [BkSp] key.

For certain operators, it may not be clear where to put the editing lines. For exam
it is not clear when looking at  or  what “before” and “after” mean. When this
happens, Mathcad resolves the ambiguity by referring to the spoken form of the 
expression. For example, since you would read  as “x conjugate,” the bar is treated 
as being after the x.

Inserting a minus sign 

The minus sign that means “opposite of” uses the same keystroke as the one that 
“subtract.” To determine which one to insert, Mathcad looks at where the vertica
editing line is. If it's on the left, Mathcad inserts the “opposite of” minus sign. If it's
the right, Mathcad inserts the “subtract” minus sign. To move the vertical editing 
from one side to the other, use the [Insert ] key.

The following example shows how to insert a minus sign in front of the expressio
“sin(a).”

■ Click on the sin(a).

■ If necessary, press [Insert ] to move the 
vertical editing line all the way to the left.

■ Type -  to insert a minus sign.

If what you really want to do is turn  into , insert another operato
(say, “+”) as described in the section “Inserting an operator” on page 62. Then rep
the operator with a minus sign as described in the section “Deleting an operator”
page 65. Notice that in Mathcad the unary minus sign in the expression  app
smaller than the minus sign in expressions such as .

Applying a function to an expression 

To turn an expression into the argument of a function, follow these steps:

■ Click in the expression and press 
[Space ] until the entire expression, 

, is held between the editing 
lines. 

x x

x

a( )sin 1 a( )sin–

a( )sin–
1 a( )sin–

w t⋅ k z⋅( )–
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■ Type the single-quote key (the same as 
the double-quote key, but unshifted). The 
selected expression is enclosed by paren-
theses.

■ Press [Space ]. The editing lines now 
hold the parentheses as well.

■ If necessary, press the [Insert ] key. 
The vertical editing line switches to the 
left side. If the vertical editing line is 
already on the left side, skip this step.

■ Now type the name of the function. If the 
function you wish to use is a built-in 
function, you can choose Function from 
the Insert menu and double-click on the name of the function.

Inserting parentheses    

Mathcad places parentheses automatically as needed to maintain the precedenc
operations. There may be instances however, when you want to place parenthe
clarify an expression or to change the overall structure of the expression. You can 
insert a matched pair of parentheses all at once or you can insert the parenthes
at a time. We recommend you insert a matched pair since this avoids the possibil
unmatched parentheses.

To enclose an expression with a matched pair of parentheses:

■ Select the expression by placing it be-
tween the editing lines. You can do this 
by clicking on the expression and press-
ing [Space ] one or more times.

■ Type the single-quote key. The selected 
expression is now enclosed by parenthe-
ses. 

It is sometimes necessary to insert parentheses one at a time using the (  and )  keys. 
For example, to change  to  do the following:

■ Move the editing lines just to the left of 
the b. Make sure the vertical editing line 
is on the left as shown. Press [Insert ] 
if necessary to move it over.

■ Type ( . Now click to the right of the c. 
Make sure the vertical editing line is to 
the right as shown. Press [Insert ] if 
necessary to move it over.

a b– c+ a b c+( )–
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■ Type ) .

Deleting parentheses

You cannot delete one parenthesis at a time. Whenever you delete one parenth
Mathcad deletes the matched parenthesis as well. This prevents you from inadver
creating an expression having unmatched parentheses.

To delete a matched pair of parentheses:

■ Move the editing lines to the right of the 
“(”.

■ Press the [BkSp] key. Note that you 
could also begin with the editing lines to 
the left of the “)”and pressing the [De-
lete ] key instead.

Moving parts of an expression    

The menu commands Cut, Copy, and Paste from the Edit menu are useful for editing 
complicated expressions. They function as follows:

■ Cut deletes whatever is between the editing lines and copies it to the clipboa

■ Copy takes whatever is between the editing lines and copies it to the clipboar

■ Paste takes whatever is on the clipboard and places it into your worksheet, ei
into a placeholder or into the blank space between equations.

The following example shows how to use Copy and Paste to eliminate retyping. 

Suppose you want to build the expression

The argument to the sine function is nearly identical to that of the cosine function.
can take advantage of the similarity between the arguments of these two functio
doing the following:

■ Build the first term, then leave a place-
holder where the argument to the sine 
should go. Type sin()  to do this.

■ Click in the argument to the cosine func-
tion and press [Space ] until the editing 
lines hold the argument between them. 
The expression looks like that shown on 
the right.

■ Choose Copy from the Edit  menu. 

wt x+( )cos wt x–( )sin+
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■ Click on the placeholder inside the sine 
function.

■ Choose Paste from the Edit  menu. The 
expression now looks like that shown on 
the right.

Now replace the “+” with a “−”.

The Copy and Paste commands described above use the clipboard to move express
from one place to another. There may, however, be times when you don't want to d
the clipboard. You can bypass the clipboard by using Mathcad's drag and drop fe

Suppose, as in the previous example, that you want to copy the expression 
and place it in the placeholder inside the sine function.

■ Select the argument to the cosine function. 
The expression looks like that shown on 
the right.

■ Press and hold down the [Ctrl ] key and 
the mouse button. The pointer changes as 
shown on the right to indicate that it car-
ries the selected expression with it. It con-
tinues to carry the selected expression until you release the mouse button.

■ With the mouse button still held down, 
drag the small box at the arrow's tip over 
the placeholder.

■ Release the mouse button. The pointer 
drops the expression into the placeholder. 
It then recovers its original form to indi-
cate that its contents have been dis-
charged.

You can drag and drop expressions into placeholders in other expressions or int
blank space in your worksheet. Just be sure you don't let go of the mouse button b
you've dragged the pointer wherever you want to drop the expression. If you're tr
to drop the expression into a placeholder, be sure to position the hollow box care
over the placeholder.

If you don't want to leave behind a copy of the expression as shown in the above
example, follow the same procedure using the [Shift ] key instead of the  [Ctrl ] key.

Deleting parts of an expression 

You can avoid having to repeatedly backspace over parts of an expression by cho
Cut from the Edit  menu. This will delete whatever is between the editing lines pla
it on the clipboard.

w t⋅ x+
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The following example shows how you can use the cut command to delete a signi
part of an expression.

Suppose you want to change the expression

into 

Rather than repeatedly backspacing, you can do the following:

■ Select the numerator as shown on the 
right.

■ Choose Cut from the Edit  menu. This 
removes the numerator and leaves behind 
a placeholder.

■  Type x  in the placeholder. 

You can also delete part of an expression by using either the [Delete ] key or the 
[BkSp] key. If you use this method however, whatever you delete will not go to the 
clipboard. This is useful when you intend to replace whatever you delete with what
is currently on the clipboard. 

To delete part of an expression without placing it on the clipboard:

■ Select the numerator as shown on the 
right. Note that the vertical editing line is 
to the right.

■ Press [BkSp]. Mathcad highlights your 
selection to indicate what you've pro-
posed to delete. Mathcad takes this extra 
step since once you delete, you'll have to 
retype the expression to get it back.

■  Press [BkSp] one more time. This re-
moves the numerator and leaves behind 
a placeholder.

w t⋅ x+
2

------------------- 
 cos

x
2
--- 

 cos
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To use the [Delete ] key instead of the [BkSp] key, follow the preceding instructions
but place the vertical editing line on the left side of the expression.

Rearranging your worksheet 

This section describes how to rearrange expressions, graphics and text in your w
sheets. The techniques described here work equally well for everything in your 
worksheet: equations, plots, sketches and text. Before you use the methods in th
section, click in the empty space between regions to turn the cursor into a crossh

You can get an overall view of how your worksheet looks by choosing Zoom from the 
View menu and choosing a magnification from the Zoom dialog box. Set the mag
cation:

■ Less than 100% to zoom out for an overall view.

■ Greater than 100% to zoom in for a close-up view.

Selecting, cutting, pasting and aligning regions work the same way regardless o
magnification you choose.

Selecting regions

Before you can move or copy one or more regions, you must select them. To do

■ Press and hold down the mouse button to anchor one corner of the selection
rectangle.

■ Without letting go of the mouse button, move the mouse so as to enclose every
you want to select inside the selection rectangle.

■ Once the selection rectangle encloses everything you want to select, release
mouse button. Mathcad encloses those regions you have selected.

Figure 3-2 shows how the worksheet might look just before you release the mou
button.
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Figure 3-2: Several regions enclosed in a selection rectangle.

Copying regions   

Once the regions are selected, you can copy them: 

■ by using Copy and Paste, or

■ if the regions start out in either an Electronic Book or in a locked area, by drag
them with the mouse

To use the Copy and Paste commands:

■ Select the regions as described in the previous section.

■ Choose Copy from the Edit  menu. This copies the selected regions into the 
clipboard.

■ Click the mouse wherever you want to place a copy of the regions. You can c
either someplace else in your worksheet or in a different worksheet altogether. M
sure you've clicked in an empty space. You should see the crosshair.

■ Choose Paste from the Edit  menu. 

If the regions you want to copy are coming from a locked area or from an Electro
Book, you can also copy them by dragging them with the mouse. To do so:

■ Select the regions as described in the previous section.

■ Place the pointer on the border of any selected region. It should turn into a sm
hand.

■ Hold down the mouse button.
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■ Without letting go of the button, move the mouse. You'll see the rectangular out
of the selected regions move as you move the mouse.

At this point, you can either copy the selected regions to another spot in the works
or you can copy them into another worksheet. 

To copy the selected regions to another spot in the worksheet, move the rectang
outlines to wherever you want to place the regions and let go of the mouse butto
you want to copy the region to a spot beyond what you can see in the window, just
the regions in the appropriate direction. Mathcad will automatically scroll in that 
direction.

To copy the selected regions into another worksheet, press the mouse button an
the rectangular outlines toward the destination worksheet. Do not linger near the
window's frame; drag the regions decisively across the frame and into the destin
worksheet. Mathcad responds to hesitation near the window's frame by autoscro
the document in the indicated direction.

Moving regions   

Once the regions are selected, you can move them by: 

■ dragging with the mouse or,

■ using Cut and Paste.

To drag regions with the mouse: 

■ Select the regions as described in the previous section.

■ Place the pointer on the border of any selected region. The pointer will turn in
small hand.

■ Press and hold down the mouse button.

■ Without letting go of the button, move the mouse. You'll see the rectangular out
of the selected regions following the mouse pointer.

At this point, you can either drag the selected regions to another spot in the works
or you can drag them to another worksheet. 

To move the selected regions to another spot in the worksheet, move the rectan
outlines to wherever you want to place the regions and let go of the mouse butto
you want to move the region to a spot beyond what you can see in the window, 
drag the regions in the appropriate direction. Mathcad will automatically scroll in t
direction.

To copy the selected regions into another worksheet, press the mouse button an
the rectangular outlines toward the destination worksheet. Do not linger near the
window's frame; drag the regions decisively across the frame and into the destin
worksheet. Mathcad responds to hesitation near the window's frame by autoscro
the document in the indicated direction.

You can also move the selected regions by using Cut and Paste. To do so:

■ Select the regions as described in the previous section.
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■ Choose Cut from the Edit  menu. This deletes the selected regions and puts th
on the clipboard.

■ Click the mouse wherever you want the regions moved to. Make sure you've cli
in an empty space. You can click either someplace else in your worksheet or
different worksheet altogether. Make sure the cursor looks like a crosshair.

■ Choose Paste from the Edit  menu. 

Aligning Regions

Once regions are selected, you can align them either horizontally or vertically by
choosing Align Regions from the Format menu. This is a pull-right menu. Drag the
mouse to the right to display two additional choices: Across and Down. You can also 
choose these commands by clicking on the appropriate button on the toolbar.

When you choose Align Regions⇒Down from the pull-right menu, Mathcad does the
following:

■ Mathcad draws an invisible vertical line halfway between the right edge of the ri
most selected region and the left edge of the left-most selected region.

■ All selected regions to the right of this line are moved left until their left edges 
aligned with this line.

■ All selected regions to the left of this line are moved right until their left edges
aligned with this line.

Choosing Align Regions⇒Across works in much the same way. Mathcad draws a
invisible horizontal line halfway between the top edge of the uppermost region an
bottom edge of the lowest region. Selected regions below and above this line are m
up and down respectively until the midpoints of their left edges are on this line.

Note that this means it is possible to inadvertently make regions overlap. If, for exam
the regions you select are almost horizontally aligned, choosing Align Regions⇒Down 
may result in overlapping regions. 

Deleting regions   

To delete one or more regions:

■ Select the regions by dragging.

■ Choose Cut from the Edit  menu.

Choosing Cut removes the selected regions from your worksheet and puts them o
clipboard. If you don't want to disturb the contents of your clipboard or if you don
want to save the selected regions, choose Delete from the Edit  menu instead.

Alternative ways to select regions

There are actually three different ways to select regions. Which one you choose de
on the arrangement of the regions you want to select. 
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The most common, selection by dragging the mouse, was discussed in a previo
section. This is useful when the regions you want to select are not too far apart, an
be enclosed in a rectangle. 

The two additional methods are:

■ Shift-clicking on the regions you want to select. 

■ Marking the two endpoints of a selection by clicking on them with the [Ctrl ] key 
held down.

Shift-clicking is useful when you want to select or deselect a region without affec
any other regions. For example, you should shift-click when:

■ You can't easily enclose the regions you want to select inside a rectangle. Fo
example, if one region is near the top of a worksheet and the other is near the bo
you cannot enclose them both in a rectangle without also enclosing many oth
regions in between. 

■ You want to add several more regions to a collection of regions you may hav
selected some other way.

■ Several regions are selected and you want to deselect one of them.

To select regions by shift-clicking, do the following:

■ Move the mouse pointer to the first region you want to select, 

■ Press and hold down the [Shift ] key and click the mouse button.

Mathcad surrounds the selected region in a selection rectangle. To select additio
regions, repeat these steps with the mouse on the region you want to select. Mak
you hold down the [Shift ] key while clicking. If you don't, Mathcad will select 
whatever you shift-click on, but deselect all other selected regions.

When there are a lot of regions to select, the selection rectangle may become unw
In such cases, you can fill in your selection by control-clicking as follows:

■ Select one or more regions either by shift-clicking, or by using the selection 
rectangle.

■ With the [Ctrl ] key held down, click on the last region in your selection.

Mathcad selects all regions between the first selected region and whatever regio
control-clicked on. This may include regions beyond the right or left edges of you
window. You can think of control-clicking as a quick way to shift-click every regio
between the first and last regions selected. 

The last region selected need not be the one you control-click on. If you control-c
on a region between two selected regions, Mathcad selects all regions between th
selected regions.

Inserting or deleting blank lines 

You can easily insert one or more blank lines into your worksheet. The procedure
follows: 
Rearranging your worksheet 75



s. 

as 

e a 

letes 

. 

to 
ends 

pping 
t they 

gure 

 to 

r-
gions 
 

■ Click on the blank line below which you want to insert one or more blank line
Make sure the cursor looks like a crosshair.

■ Press [↵] to insert a blank line and move the cursor to the left margin. Do this 
many times as you want to insert lines.

To delete one or more blank lines from your worksheet:

■ Click above the blank lines you want to delete. Make sure the cursor looks lik
crosshair and that there are no regions to the right or left of the cursor.

■ Press [Delete ] as many times as there are lines you want to delete. Mathcad de
blank lines below your cursor.

■ Alternatively, press [BkSp] as many times as there are lines you want to delete
Mathcad deletes blank lines above your cursor.

If you press either [Delete ] or [BkSp] and nothing seems to be happening, check 
make sure that the cursor is on a line all by itself. If any region in your worksheet ext
into the line you are trying to delete, Mathcad won't be able to delete that line.

Separating regions 

As you move and edit the regions in a Mathcad worksheet, they may end up overla
one another. Overlapping regions don't interfere with each other's calculations, bu
do make worksheets hard to read.

A good way to determine whether regions overlap is to choose Regions from the View 
menu. Mathcad will display blank space in gray and leave the regions in white. Fi
3-3 shows an example.

To separate all overlapping regions, choose Separate Regions from the Format menu. 
Wherever regions overlap, this command will move the regions in such a way as
avoid overlaps while preserving the order of the calculations.

Be careful with the Separate Regions menu command since not only can it have fa
reaching effects, it also cannot be undone. As an alternative, consider dragging re
individually, adding lines by pressing [Insert ], or cutting and pasting the equations
so they don't overlap.

Figure 3-4 shows the worksheet from Figure 3-3 after having chosen Separate Regions 
from the Format menu. To turn the blank space back into white, choose Regions from 
the View menu again.
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Figure 3-3: Worksheet with overlapping regions.

Figure 3-4: After separating the regions.
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